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Preface 
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Some spreadsheet users shy away from using Data Tables 
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or how to create them. In fact, Data Tables are simple 

to construct and use and are well worth the effort to learn. 
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Introduction  
 

Data Tables are a tool used frequently in Excel models to track how small changes in 
inputs affect the results of formulas in your model that are dependent on those inputs. For 
example, you might be interested in knowing how changes in the price your firm charges 
for an item affect the firm’s net income. An analysis of this sort is often termed a 
sensitivity analysis.  
 
Excel has two varieties of Data Table:  
 

The One-Variable Data Table  
The Two-Variable Data Table  

 
 
Both varieties work in a similar fashion. You identify one or two key input variables in 
your model and describe the range of values you want those inputs to take on. Then you 
identify one or more formulas in your model that are dependent on those inputs. When 
you execute the Data Table command, Excel then iterates through a process of executing 
each formula you’ve identified, substituting in each formula each one of the values you’ve 
identified for the key input variables, and recording how the value changes change the 
results of the formulas.  
 
The One-Variable Data Table allows identification of a single input variable but an 
unlimited number of formulas. The Two-Variable Data Table allows identification of two 
input variables but only a single formula. The layout of your Data Tables is important and 
must follow Excel’s rules for Data Tables.  
 
Advantages to using a Data Table include:  
 
The ability to use an unlimited number of values as inputs to one or more  
key formulas in your model.  

• Having the Data Table generate outputs in a condensed matrix, making it easy to 
see all the possibilities you want to view and compare.  

• The option to select the most viable or interesting result values as inputs into 
Excel’s Scenario Manager, if you want to focus on a handful of most interesting 
values and scenarios.  

 
Adjuncts and/or alternatives to using a Data Table:  
 

• Entering inputs by hand one at a time and keeping manual track of the results or 
saving the results on separate worksheets (tedious work perhaps resulting in 
hundreds of worksheets).  

• Using Excel’s Solver and its Sensitivity Report.  
 
The rest of this document discusses how to construct and execute Excel Data  
Tables.  
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The One-Variable Data Table: Basics  
 

The One-Variable Data Table allows you to identify a single decision variable in  
your model and see how changing the values for that variable affect the values  
calculated by one or more formulas in your model.  
 
How to Create a One-Variable Data Table  
 
Design your one-variable Data Table so that input values are listed either down a  
column (column-oriented; most common) or across a row (row-oriented).  
Formulas used in a one-variable Data Table must refer to an input cell1 for your  
spreadsheet model.  
 
1. Type the list of values you want to substitute in the input cell either down one column or 

across one row.  
 
2. If the input values are listed down a column, type the formula in the row above the first 

value and one cell to the right of the column of values. Type any additional 
formulas to the right of the first formula. If the input values are listed across a row, 
type the formula in the column to the left of the first value and one cell below the 
row of values. Type any additional formulas below the first formula.  

 
3. Select the range of cells that contains the formulas and values you want to substitute.  
 
4. On the “Data” tab find the “Data Tools” 

group and click the drop-down for 
“What-If Analysis”.  Then choose Data 
Table…. Excel displays a “Data Table” 
dialog that asks you to identify the cell 
reference for the input cell. If the Data 
Table is column-oriented, type the cell 
reference for the input cell in the 
“Column input cell” box. If the Data Table is 
row-oriented, type the cell reference for the 
input cell in the “Row input cell” box.  

 
5. Click OK to have Excel execute the Data Table and 
fill the Data Table matrix with values.  
 
 
Understanding how to structure your Data Table and respond to the “Table” dialog 
prompt is the key to a successful Data Table.  

 

                                                 
1 A cell in which a list of input values from the Data Table is substituted. Any cell on the  
worksheet can be designated as the input cell. The formulas that are part of the Data Table must refer to the 
input cell. 
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A Simple One-Variable Data Table Example  
 

In the example below, the One-Variable Data Table is arranged in a column  
orientation. The column with the label “Units Sold” holds the Data Table input  
values. It’s important to note that “Units Sold” is also a value in the monthly  
income statement model at left, under the “Revenue” header (Cell C5).  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
A One-Variable Data Table can contain more than one formula. The Data Table above 
contains three formulas arranged across the top of the Data Table (one row above the first 
of the Units Sold inputs). The formulas calculate “Revenues”, “Total Expenses”, and 
“Operating Income” in the model. In fact, the cells that hold the formulas in the Data Table 
(F7:H7) contain references to cells in the model. Cell F7 in the Data Table references Cell C7 
in the model, Cell G7 in the Data Table references Cell C22 in the model, and Cell H7 in the 
Data Table references Cell C23 in the model. When constructing a Data Table, you can 
either reference a formula in your model elsewhere in the spreadsheet or re-enter the 
formula in the Data Table.  
 
To execute the Data Table in the example above,  
highlight the Data Table range (E7:H14 excluding any 
labels you might have added around the Data Table) and 
from the “Data” tab “Data Tools” group choose “What-If 
Analysis” and then Data Table…. In the “Data Table” 
dialog that displays, enter C5 in the “Column  
input cell” box. (Excel automatically changes the  
reference from relative to absolute.) Click OK.  
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Excel executes the Data Table and fills the Data Table matrix with values.  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

The result allows you to see the effect of eight different Units Sold values on revenue, 
expenses, and operating income. For example, if the company sells 1,500 units per month, 
the model predicts that revenues will total $148,500, expenses will total $120,000 and 
operating income will be $28,500.  

 
Practice Creating a One-Variable Data Table  

 
For this exercise, start with a copy of the XerTech Exercise Excel workbook2. The 
“XerTech” worksheet in the workbook looks like this:  

 
 
 
 

                                                 
2 Downloadable from http://faculty.fuqua.duke.edu/~pecklund/ExcelReview/ExcelReview.htm#Special. 
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First, enter the formulas required to complete this spreadsheet model. (We’ll track the 
results of these formulas with a Data Table.) The locations of these formulas are indicated 
in the worksheet by grayed cell backgrounds.  
 
 
Formulas to use:  
Cell B7  Fixed Expense per Copier is a sum of the three costs in B4:B6.  
Cell B12  Revenue = Number of Copiers Leased X Copies/Month/Copier multiplied 

by Price Charged per Copy  
Cell B13  Cost of Goods Sold = Number of Copiers Leased multiplied by 

Copies/Month/Copier X Variable Cost per Copy  
Cell B14  Contribution Margin = Revenue minus Cost of Goods Sold  
Cell B15  General & Admin. Costs = Number of Copiers Leased multiplied by the 

sum of the Fixed Expense per Copier and the Space Rental Rate.  
Cell B16  Net Income = Contribution Margin minus General & Admin. Costs.  
 
The Margin per Copy calculation in E7 (Price Charged minus Variable Cost) is completed 
in the worksheet for you.  
 
When you’ve completed entering the formulas as specified above, your worksheet will 
look like this:  
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The Net Income figure in Cell B16 is a key value in 
this model and one that you want to maximize. You 
may wonder how copy volumes affect Net Income. 
Try changing the value in Cell B11 
(Copies/Month/Copier) to see the effect on Net 
Income. For example, change the value from 30,000 
to 45,000. Net Income changes to $16,600.  
 

 
 

 
Or, change the Copies/Month/Copier  
value to 65,000 or some other number to  
see a different effect on Net Income. In the  
example at right, the Net Income changed  
to $32,600.  
 
 

But what if you want to see the effect on Net Income for many different values for 
Copy/Month/Copier volume? How about 10 different values? Or 100 different 
values? Or 1000? Constructing a One-Variable Data Table will allow you to quickly 
see how sensitive the Net Income value is to changes in copy volume. To build this 
One-Variable Data Table:  

 
1. Start in a blank area of your worksheet to the right of your Monthly data (Cell 

E11). Enter values down that column for copy volumes 
(Copies/Month/Copier) ranging from 24,000 to 44,000. These are your Data 
Table input values.  
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2. You want to track how changes in copy volumes affect Net Income. So in the 
cell to the right of the top value in your input column and one row above it, 
enter the Net Income formula from your model. To do this you can either type 
in the formula (=B14B15) or refer to the cell in your model that already contains 
the formula (=B16). The value that appears in this cell should be $4,600.  
  
  
  
  
  
  
  
 
 
 
 
 

3. Drag over the cells to the right of the input value and 
below the formula so the entire matrix appears in 
reverse video. Your selection should include both the 
column of inputs and the cells to their immediate right 
as well as the formula at the top and the empty cell to its 
left.  
 
 

4. To begin execution of the Data Table, choose the “What-If Analysis” drop-down 
in the “Data Tools” group on the “Data” tab and select Data Table…  Excel 
displays the “Table” dialog with prompts both for a Row input cell and a 
Column input cell.  

 
 
 
 
 
 
 
 
 

With a One-Variable Data Table we have only a single input so we supply only one 
value in the “Table” dialog.3 And because our input values are arranged in a 
column, we supply a value for the “Column input cell”.4  

                                                 
3 For a Two-Variable Data Table we would supply values both for row input and column input.  
4 If we arranged our inputs in the One-Variable Data Table along a row instead of in a column we  
would enter a cell reference in the “Row input cell” box instead. 
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What should we enter for “Column input cell”? To understand what’s required here, 
understand that when we execute the Data Table, the Data Table will run through as many 
iterations of our model as we have input values. On each iteration, the Data Table will 
substitute a different input value for Copies/Month/Copier (Cell B11) in our model and 
record the effect that particular input value has on the Net Income formula. This process is 
the equivalent of your entering these different input values one by one into Cell B11 of the 
model and writing down the effect of each one of those changing values on Net Income. 
Instead of our using this tedious “by-hand” approach, the Data Table executes this 
sequence very quickly and automatically records the results inside the Data Table matrix.  

 
In the Column input cell text box, enter B115 or point to that cell and have Excel fill in the 
cell reference for you. Note that you’re not entering a value here, but a cell reference to the 
cell in your model whose value Excel will vary as it iterates through the Data Table. On 
each iteration, the Data Table will — in sequence — substitute one of the input values 
you’ve specified in your Data Table input column.  

 
5. Once you’ve specified the Column input cell in the “Table” dialog, click the OK button 

and let Excel run the Data Table and complete the results matrix for you.  
 

6. Your completed One-Variable Data Table should look like this:  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
 
The values under the Net Income formula (shown as $4,600) are the values the Data 
Table generated during its iterations of the model.  

 

                                                 
5 You need not enter an absolute reference. If instead of entering a cell reference you point to the  
cell and have Excel enter the cell reference for you, Excel enters an absolute reference. 

Values 
generated by the 
Data Table. 
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Reading across the rows of the Table we can see, for example, that if the volume of 
Copies/Month/Copier is 24,000, Net Income will be a negative $200. If instead 
Copies/Month/Copier is 44,000 then Net Income will be $15,800.  

 
I formatted the result values as currency. You can format Data Table values in any way 
you like.  

 
 
 
The One-Variable Data Table: Modifications and Refinements  
 
 

Modifying the One-Variable Data Table  
 

You can change the input values down the left-hand column of 
the Data Table. The Data Table recalculates automatically.  

 
In the example at right I’ve changed the input values to get a 
better picture of the effects of lower copy volumes. I changed 
the input values from my original Data Table (24,000 to 44,000) 
to range from 22,000 to 32,000. The values in the second column 
of the Data Table recalculated automatically.  

 
 

 
 
 
You can also extend the number of input values in your Data Table if you 
want to see more possibilities. If you do so, however, you must re-execute 
the Data Table (reselect the new, expanded Data Table cells and go through 
the Data, Table  
commands). The new Data Table results overwrite anything that was 
previously in those cells. 
 
Although you can format individual result cells, you can’t  
delete individual cells or change their values. If you attempt  
to delete only a portion of a Data Table’s results Excel  
displays this error dialog:  
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Making the One Variable Data Table More Powerful by Adding Additional  
Formulas  

 
When you examine the model you’ll note that the values for Revenue, Cost of Goods Sold, 
Contribution Margin, and General & Admin. Costs change each time you change the value 
for Copies/Month/Copier. Can you track how sensitive each one of these values is to copy 
volume using a One-Variable Data Table? The answer is yes.  

 
A characteristic of a One-Variable Data Table is that it can have only one input variable but 
it can include any number of formulas, provided those formulas depend in some way on 
the Data Table input values.  

 
Extend your One-Variable Data Table to include a sensitivity analysis for the effects of 
Copies/Month/Copier on Revenue, Cost of Goods Sold, Contribution Margin, and 
General & Admin. Costs. To do this:  

1. Enter each one of those formulas (or references to the cells holding those 
formulas) in the same row as the existing Net Income formula.  

2. Re-select the Data Table matrix. That is, the rectangle of cells that encompasses 
the input values, all the cells to their right as well as the Net Income cell and all 
the other formula cells to its right along with the blank cell in the upper left-
hand corner.  

3. Go through the commands to run the Data Table and in the “Data Table” dialog 
again identify Cell B11 as the Column Input Cell.  

4. Click OK to close the dialog and execute the Data Table.  
 

Your resulting Data Table will look something like this (partial view):  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

A Data Table Formatting Note  
In the illustration above, I’ve added a row of text labels above the cells holding formulas to 
make the Data Table results easier to read. Another option is to reformat the cells holding 
the actual formulas so they display text labels instead of displaying the results of the 
formulas. This reformatting doesn’t affect the results generated by the Data Table in any 
way but it makes the Data Table easier to read.  
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With the formula cells reformatted, for example,  
 

Instead of displaying:  You see:  
$10,000    Revenue  
$6,000     COGS  
$4,000     Contrib. Margin  
$19,400    Gen/Admin Costs  
 

 
To reformat your Data Table formula cells in this fashion  

1. Select the cell you want to reformat.  
2. Right-click the cell and choose the Format Cells option on the context menu 

that displays. The Format Cells tabbed dialog opens.  
3. Choose the Number tab to bring that tab to the front, if necessary.  
4. Choose the Custom option on that tab.  
5. Replace whatever is currently in the “Type” box with the text label you 

want to use for the cell. Enclose the label name in double quote marks. For 
example:  

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
 
At left, row 9 holds text labels. Row 10 shows the first 
Data Table formula cell reformatted to display the 
text “Net Income”. 
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An Extension: Create Scenarios for Key Values  
 

At this point you’ve built a One-Variable Data Table to see the effect of copy volumes on 
Net Income. You extended your Data Table to allow you to see the effect of copy volumes 
on these other key values in the model:  

 
Revenue  
Cost of Goods Sold  
Contribution Margin  
General & Admin. Costs  

 
The Data Table results are in a convenient and compact matrix making it easy to spot 
break-even values and to compare values.  

 
What if there are some key value combinations you particularly want to highlight? Perhaps 
you’re giving a pitch to a manager or boss or there are a few key scenarios you want to be 
able to return to by looking at them as part of in your model and not by finding them in 
your Data Table results matrix?  

 
If you have any of these needs, Excel’s Scenario Manager is useful. The Scenario Manager 
allows you to specify particular scenarios and name them and then return to a view of any 
one of your scenarios by selecting that scenario by name. The Scenario Manager can also 
create a summary of your scenarios for you.  

 
To generate Scenarios:  
1. Open your spreadsheet model.  
2. From the same “What-If Analysis” button drop-down you used to select the Data Table 

option, choose Scenario Manager… to open the “Scenario Manager” dialog. Using this 
dialog you can define the different scenarios you want to track for your model. 
Generally, you’d define a half-dozen or fewer of the scenarios you’re mostly likely to 
want to return to for additional study.  
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3. Click the Add button to begin defining the first scenario. I like to begin by naming 
and defining the status quo in the model. In this case, the status quo is where 
Copies/Month/Copier is 30,000.  

 
 
 
 
I’ll name that scenario “Expected 
Demand” and indicate that the 
“Changing cell(s)” is B11, the cell 
that holds the value for 
Copies/Month/Copier.  
 
 
Click OK to see the prompt for the 
Changing Cell value for this 
Scenario.  
 
 
 
 
 

 
4. Enter the value you want this Scenario to use for the Changing Cell you’ve 

identified.  
 
 
 
 
 
 
 
 
 

5. Click OK to return to the main “Scenario Manager” dialog where you can again hit 
the Add button to define another Scenario. For practice, you might include these 
three Scenarios:  

 
Scenario Name  Copies/Month/Copier 

Value 
Expected Demand 
 30,000 

Very Low Demand  
 5,000 

Very High Demand 
 50,000 
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When you have all three Scenarios added, your “Scenario Manager” dialog will look like 
this:  

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

6. To use one of the Scenarios, click its name in the “Scenarios” list and then click the 
Show button. Excel changes the model to display the value of Copies/Month/Copier 
associated with that particular scenario and any values dependent on that value (such 
as Revenue, Cost of Goods Sold, Contribution Margin, and General & Admin. Costs) 
change too.  

 
For example, if you choose the “Very Low Demand” Scenario and ask the Scenario 
Manager to show you that option, the key parts of your model will look like this:  

 
 
 
 
 
 
 
 
 
 
 
 
 

The Copies/Month/Copier value is changed to 5,000 (very low demand) and the values 
for the formulas under the “Monthly” column have changed accordingly.  
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This permits you to view the effect of a change in volume within the model itself, if 
that’s more effective than viewing it in the context of a Data Table. You might use the 
Data Table first to see the effects of a large range of values and then focus on particular 
values by putting making them Scenarios in the Scenario Manager.  

 
7. If you want the Scenario Manager to generate a summary of your Scenarios for you, 

first identify all the Scenarios you’re interested in and then click the Summary 
button on the main “Scenario Manager” dialog. In the “Scenario Summary” dialog 
that displays, choose Scenario summary as the “Report type”. For “Result cells”, 
identify any cells in your model that change as a result of your changing Scenarios 
and whose values you want to track. For our model, likely values to have the 
Scenario Manager track might be Revenue, Cost of Goods Sold, Contribution 
Margin, and General & Admin. Costs. You can identify that range of cells by 
entering B12:B16 in the “Result cells” text box.  
  
  
 

 
 
 
 
 
 
  
  
 

8. Click OK to generate the Scenario Summary. Excel puts the summary on a new 
worksheet. The summary looks like this:  

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Excel displays the summary in outline format. Plus and minus boxes in the summary’s left-
hand margin allow you to expand or condense the summary display. The margin boxes 
holding “1” and “2” are an alternative means for expanding and condensing.  
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The Two-Variable Data Table  
 

Excel’s Two-Variable Data Table works in a fashion similar to the One-Variable Data Table. 
However, with the Two-Variable Data Table you can specify two decision variables and a 
variety of inputs and only a single formula.  

 
Continuing with the XerTech example, if we wanted to track the effect of both copy 
volume and price charged per copy on Net Income, we could set up a Two-Variable Data 
Table to look like this:  
 
 
 
 
 
 
 
 
 
 
 
 

 
In the upper left-hand cell of the Data Table is a copy of the formula from elsewhere in the 
model or a reference to the cell that holds the formula in the model.  

 
Down the left-most column are the copy volumes we want the Data Table to track. And 
across the upper row are the price-per-copy charges we want the Data Table to track. 
When executed, the Data Table will fill the matrix with Net Income values for each 
combination of copy volume and price-per-copy that we’ve included.  

 
Execute the Two-Variable Data Table in the same way you would execute the One-Variable 
Table. That is, select the entire matrix to the right and below the values you’ve specified, 
choose Data, Table, and complete the “Table” prompt that displays.  

 
This time, because you’ve specified two inputs, you must enter values for both Row input 
cell and Column input cell in the “Table” dialog. In our example, Copies/Month/Copier 
(Cell B11) is our column input and Price charged per copy (Cell E5) is our row input.  
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Click the OK button to execute the Data Table and see the results:  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Just as for the One-Variable Data Table:  
• You can format the results in any way you choose.  
• You can change any input value (down the left-hand column or across the top row) and 

the Data Table will automatically recalculate.  
• You can add additional input values and recalculate the Data Table by re-selecting the 

new area and re-executing.  
• You can not change a results value or erase a single results value or a group of results 

values from the Data Table results matrix. Instead, you must erase all values or rerun 
the Data Table. 

 
Graphing the Results of the Data Table Analysis  
 

You may want to display the results of your sensitivity analysis by means of a graph. In 
most cases, graphing a subset of your results will prove to be more effective than 
attempting to graph the entire results matrix. In this case, I’m interested in the relation 
between copy volume and the $0.05 charge per page. Let’s see how to chart the data using 
an XY (scatter) plot and then see why this is a particularly effective chart type for this data.  
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To chart the data:  
1. Highlight the portion of the Data Table that holds the data you want to graph. In this 

case, I’m interested in the relation between copy volume and the $0.05 charge per page.  
 
 
 
 
 
 
 
 
 
 
 

2. From the “Insert” tab on the ribbon find the “Charts” group and choose “Scatter”. The 
chart will initially look like the one below (depending on which sub-type of the scatter 
plot you’ve selected). 

 
 
 
 
 
 
 
 
 
 

Click any element in the chart to select it and then right-click to see reformatting options. 
Formatting/reformatting you might want to consider:  

• Adding a chart title. 
• Reducing the size of the Y axis labels.  
• Changing the scale and size of the X axis.  
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Why is the XY chart the best chart type for this data? Unlike all Excel’s other chart types, 
the XY chart can plot two groups of numbers as a single series of XY coordinates. It can 
effectively show uneven intervals or clusters of data because the X axis – as well as the Y 
axis – is used to represent data values. By contrast, in the more commonly-employed line 
or column charts, the X axis is used to identify different categories while the Y axis is the 
“value” axis.  

 
In our XY chart the Y axis is scaled to track net income and the X axis – instead of 
indicating categories – is scaled to track copy volume. Because our original volume data 
increases in a regular sequence, plotting the data as a bar, column, or line charts might at 
first glance appear useful. But what if the data were different? Let’s change our volume 
data in the Data Table to an irregular sequence, as indicated at right, below:  

 
Original Sequence   Changed Sequence  

 
 
 
 
 
 
 
 
 
 
 
 
 
 

When we make our Data Table data sequence uneven, the XY chart looks like this:  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

16,000
21,000
24,000
27,500
30,000
32,000
35,000
35,700
41,321
48,000

20,000  
22,000  
24,000  
26,000  
28,000  
30,000  
32,000  
34,000  
36,000  
38,000  
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With an XY chart, the values on the horizontal (X) axis appear in a regularly-spaced 
sequence, but the plotted data points do not need to be spaced regularly in the horizontal 
direction. Instead, they reflect the actual data.  

 
Note, by contrast, how the same data appears when plotted as a line chart. In the chart 
below, copy volume appears as the top line and net income as the line beneath. Although 
this chart does show the data, it’s quite difficult to read properly. Excel scales the chart’s Y 
axis to handle both the largest copy volume (up to 48,000) as well as the largest net income 
value (up to $19,000). The viewer is left to correlate each point on the top line with its 
corresponding point on the bottom line, which is not an easy task. If a chart should provide 
an alternate view of the data that tells a story about the data, this chart is not a success.  

 
 
 
 
 
 
 
 
 
 
 
 
 
 

A bar chart of the data is also misleading & hard to read. 
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In summary, the XY chart type best tells the story of our data:  
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
Even a quick glance at the XY chart shows us that as copy volumes increase, net income 
rises. And, that the break-even point is around a volume of 24,000 pages. The uneven 
progression of the volume values is more obvious here, where it’s quite subtle in the other 
chart types.  

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

End 


